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Informacje o module 

Opis modułu 

W tym module znajdziesz informacje dotyczące kaskadowych arkuszy 
stylów i zalet wynikających z ich stosowania. Zobaczysz, w jaki sposób 
używad selektorów i jak utworzyd układ strony wykorzystując 
pozycjonowanie CSS. Dodatkowo nauczysz się, jak zmienid istniejący 
dokument HTML wykorzystujący formatowanie przy pomocy tabel, aby był 
zgodny ze standardem XHTML i przyjazny dla CSS. 

Cel modułu 

Celem modułu jest przedstawienie możliwości wykorzystania kaskadowych 
arkuszy stylów do określenia wyglądu dokumentu XHTML, jak również 
przedstawienie zasad pracy z arkuszami stylów w Visual Studio. 

Uzyskane kompetencje 

Po zrealizowaniu modułu będziesz: 

 wiedział czym są i gdzie warto stosowad kaskadowe arkusze stylów 

 potrafił tworzyd nowe strony przyjazne dla kaskadowych arkuszy 
stylów 

 rozumiał potrzebę przystosowania istniejących dokumentów HTML 
do wymagao standardu XHTML 

Wymagania wstępne 

Przed przystąpieniem do pracy z tym modułem powinieneś: 

 znad podstawy języka XHTML (patrz: moduł „Wprowadzenie do 
XHTML”) 

 rozumied zasady grupowania elementów przy pomocy znaczników 
<div> i <span> 

 znad zasady pracy w środowisku Visual Studio, w szczególności 
tworzenia stron internetowych zgodnych z XHTML 

Mapa zależności modułu 

Zgodnie z mapą zależności przedstawioną na Rys. 1, przed przystąpieniem 
do realizacji tego modułu należy zapoznad się z materiałem zawartym 
w module „Podstawy HTML”. 

MODUŁ 2

MODUŁ 13

MODUŁ 4

MODUŁ 7

MODUŁ 1

MODUŁ 6

MODUŁ 3

MODUŁ 5

MODUŁ 8
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MODUŁ 10

MODUŁ 11

MODUŁ 12

 
Rys. 1 Mapa zależności modułu  
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Przygotowanie teoretyczne 

Przykładowy problem 

Mając już pewne doświadczenie z językiem HTML, na pewno próbowałeś określid układ elementów 
na stronie przy pomocy tabel, a jej wygląd przy pomocy znaczników takich jak <i>, <b> czy 
<font>. Stosując takie podejście prędzej czy później zauważysz jego oczywiste wady. Przy bardziej 
złożonych stronach kod HTML staje się nieczytelny, a próba zmiany stylu lub układu elementów 
pociąga za sobą koniecznośd wprowadzenia poprawek w wielu miejscach w kodzie. Co więcej, jeśli 
strona, którą tworzysz, jest tylko jedną z wielu stron w serwisie, to zmiany najprawdopodobniej 
trzeba wprowadzid również w pozostałych dokumentach. Rozwiązaniem tych problemów może byd 
oddzielenie treści dokumentu od jego prezentacji. Niestety język HTML nie wspiera takiej 
możliwości. Do tego celu powszechnie wykorzystuje się inne narzędzie – kaskadowe arkusze stylów 
lub w skrócie CSS (ang. Cascading Style Sheets). 

O ile tworzenie reguł CSS nie jest trudne, o tyle nauka efektywnego posługiwania się nim może 
zająd dużo więcej czasu, niż w przypadku języka HTML. Musisz nie tylko wiedzied, jakie właściwości 
mają poszczególne elementy HTML, lecz również jak właściwości te są interpretowane przez 
najpopularniejsze przeglądarki. Ponadto musisz nauczyd się odpowiednio przygotowywad 
dokumenty HTML i poprawnie pozycjonowad elementy na stronie. 

Podstawy teoretyczne 

Kaskadowe arkusze stylów to mechanizm używany do opisywania wyglądu dokumentów HTML. 
Wśród głównych zalet wynikających z jego stosowania wymienid można: 

 Łatwiejsze zarządzanie wyglądem dokumentów – CSS pozwala grupowad informacje 
o wyglądzie poszczególnych elementów strony, jak również wykorzystywad je wielokrotnie, 
nawet przez wiele dokumentów. 

 Mniejszy rozmiar stron – stosowanie arkuszy stylów pozwala zmniejszyd rozmiar 
dokumentów HTML i ogólnie ograniczyd ilośd danych, jakie musi pobrad użytkownik, by 
wyświetlid je w przeglądarce – w przypadku, gdy wiele stron wykorzystuje ten sam arkusz 
CSS, jest on pobierany przez przeglądarkę tylko raz. 

 Oddzielenie treści od wyglądu dokumentów – dzięki CSS można oddzielid zawartośd stron 
od ich wyglądu, dzięki czemu ich treśd staje się łatwiej dostępna np. dla wyszukiwarek 
internetowych lub czytników ekranowych, wykorzystywanych przez osoby niewidome. 

Reguły CSS 

Arkusz CSS stanowi zbiór reguł, które informują przeglądarkę, jak wyświetlad określone elementy 
na stronie. Każda reguła składa się z dwóch części: tzw. selektora i definicji, którą tworzy zbiór par 
właściwość-wartość: 

selektor { właściwość: wartość[; właściwość: wartość[;...n] ]  } 

Selektor określa, jakich elementów strony dotyczy reguła, definicja zaś mówi, jakie wartości 
powinny przyjąd wybrane właściwości tych elementów, takie jak kolor czy styl tekstu. Przykładowo 
następująca reguła: 

h1 { font-family: Arial; font-style: italic; } 

określa, że tekst wewnątrz wszystkich elementów h1 na stronie powinien zostad wyświetlony 
krojem Arial, pismem pochyłym.  

Rodzaje selektorów  

Selektory to jedne z najważniejszych aspektów CSS. Dzielą się one na kilka rodzajów, z których te 
najczęściej używane omówimy w kolejnych punktach. 
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Selektor typu 

Selektor typu odnosi się do wszystkich elementów określonego rodzaju. Przykładowo reguła: 

h1 { font-weight: bold }  

zostanie zastosowana dla wszystkich elementów h1 w dokumencie. 

Selektor klasy 

Selektor klasy odnosi się do wszystkich elementów o określonej wartości atrybutu class. 
Przykładowo reguła: 

.akapit { font-weight: bold; } 

zostanie zastosowana dla elementów dowolnego rodzaju, którym przypisano klasę akapit, np.:  

<p class="akapit">…</p> 

Selektor ID  

Selektor ID działa na podobnej zasadzie, co selektor klasy, z tymże wybiera elementy o określonej 
wartości atrybutu id. Ponieważ wartośd tego atrybutu jest unikatowa, selektor tego typu zawsze 
odnosi się do co najwyżej jednego elementu na stronie. Przykładowo reguła: 

#stopka { font-weight: bold; } 

zostanie zastosowana dla elementu dowolnego rodzaju posiadającego atrybut id="stopka", np.: 

<div id="stopka">…</div> 

Łączenie selektorów 

By precyzyjniej określid elementy, poszczególne rodzaje selektorów można łączyd ze sobą. 
Przykładowo reguła: 

p.akapit { font-weight: bold; } 

zostanie zastosowana wyłącznie dla takich elementów p, którym przypisano klasę akapit. 

Definiowanie stylów dla dokumentu HTML 

Reguły możemy definiowad: 

 bezpośrednio w dokumencie HTML, w nagłówku strony: 

<head> 
 … 
 <style type="text/css"> 
  h1 { color: olive; } 
  p  { color: gray;  } 
 </style> 
</head> 

 w dokumencie HTML jako wartośd atrybutu style wybranych elementów: 

<h1 style="color:olive">…</h1> 
<p style="color:gray">…</p> 

 w zewnętrznym pliku CSS – wymagane jest wskazanie go przy pomocy elementu link , np.: 

<head> 
 … 
 <link rel="stylesheet" type="text/css" href="style.css" /> 
</head> 
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Praca z CSS w środowisku Visual Studio 2008 

Środowisko Visual Studio udostępnia wizualny edytor reguł CSS (Rys. 2), który można przywoład 
wybierając z menu Format -> New Style. 

 
Rys. 2 Okno New Style, kategoria Font 

Najważniejsze pola w edytorze to: 

 Selector – selektor dla reguły. 

 Define In – miejsce przechowywania reguły, może byd nim nagłówek aktualnej strony lub 
zewnętrzny arkusz stylów. 

 URL – lokalizacja zewnętrznego arkusza stylów. 

 Preview – podgląd zdefiniowanego formatowania. 

 Description – podgląd definicji reguły. 

 Category – lista kategorii, na które podzielone zostały właściwości elementów HTML. 

Kategoria Font 

W kategorii Font (Rys. 2) znajdują się opcje pozwalające określid sposób wyświetlania tekstu. 
Przykładowe właściwości: 

 font-family – krój pisma 

 font-size – stopieo pisma 

 color – kolor tekstu 

Kategoria Block 

W kategorii Block (Rys. 3) znajdują się opcje pozwalające określid sposób ułożenia tekstu wewnątrz 
elementów blokowych.  

 
Rys. 3 Okno New Style, kategoria Block 
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Przykładowe właściwości: 

 line-height – odległośd między sąsiednimi liniami tekst 

 vertical-align – ułożenie tekstu w pionie 

 text-align – ułożenie tekstu w poziomie 

Kategoria Background 

W kategorii Background (Rys. 4) znajdują się opcje pozwalające określid wygląd tła elementu. 

 
Rys. 4 Okno New Style, kategoria Background 

Przykładowe właściwośd: 

 background-color – kolor tła 

 background-image – obraz wyświetlany w tle 

 background-repeat – powtarzanie obrazu wyświetlanego w tle w pionie i/lub w poziomie 

Kategoria Border 

W kategorii Border (Rys. 5) znajdują się opcje pozwalające określid wygląd obramowania wokół 
elementu. 

 
Rys. 5 Okno New Style, kategoria Border 

Opcja Same for all umożliwia zastosowanie tych samych ustawieo dla wszystkich krawędzi 
obramowania. Przykładowe właściwości: 

 border-style – styl obramowania 

 border-width – grubośd obramowania 

 border-color – kolor obramowania 
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Kategoria Box 

W kategorii Box (Rys. 6) znajdują się opcje pozwalające określid marginesy zewnętrzne 
i wewnętrzne elementów. 

 
Rys. 6 Okno New Style, kategoria Box 

Opcja Same for all umożliwia zastosowanie tych samych ustawieo dla wszystkich marginesów. 
Właściwości: 

 padding – rozmiar marginesu wewnętrznego 

 margin – rozmiar marginesu zewnętrznego 

Kategoria Position 

W kategorii Position (Rys. 7) znajdują się opcje pozwalające określid rozmiar i położenie 
elementów.  

 
Rys. 7 Okno New Style, kategoria Position 

Przykładowe właściwości: 

 position – rodzaj pozycjonowania (statyczne, względne lub bezwzględne) 

 width – szerokośd elementu 

 height – wysokośd elementu 

 left – położenie lewej krawędzi elementu (zależy od rodzaju pozycjonowania) 

 top – położenie górnej krawędzi elementu (zależy od rodzaju pozycjonowania) 
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Kategoria Layout 

W kategorii Layout (Rys. 8) znajdują się opcje pozwalające określid zaawansowane pozycjonowanie 
elementów na stronie.  

 
Rys. 8 Okno New Style, kategoria Layout 

Przykładowe właściwości: 

 visibility – widocznośd elementu 

 float – przyciąganie elementu do krawędzi bocznych innych elementów (tzw. pływanie) 

 clear – zakaz możliwości przyciągania innych elementów do krawędzi bocznych elementu 

Kategoria List 

W kategorii List (Rys. 9) znajdują się opcje pozwalające określid wygląd list.  

 
Rys. 9 Okno New Style, kategoria List 

Właściwości: 

 list-style-type – rodzaj listy (numerowana lub punktowana) 

 list-style-image – obrazu używany jako punktor w listach punktowanych 

 list-style-position – położenie punktora 

Podsumowanie  

W tym rozdziale przedstawione zostały najważniejsze pojęcia związane z kaskadowymi arkuszami 
stylów. Dowiedziałeś się, czym są reguły i jak stosowad je do wybranych elementów strony 
wykorzystując selektory. 

Chod do edycji kaskadowych arkuszy stylów wystarczy najprostszy edytor tekstu, Visual Studio 
udostępnia dużo wygodniejszy, wizualny edytor stylów, wyposażony m.in. w dynamicznie 
aktualizowany podgląd formatowania i możliwośd zarządzania umiejscowieniem reguł. 
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Przykładowe rozwiązanie 

Przygotowanie dokumentu HTML przyjaznego dla CSS 

Zanim będziemy mogli zdefiniowad wygląd elementów na stronie przy pomocy kaskadowych 
arkuszy stylów, powinniśmy najpierw odpowiednio przygotowad dokument HTML. Wyobraźmy 
sobie, że chcemy przy pomocy HTML i CSS stworzyd stronę o ułożeniu elementów jak na Rys. 10. 

 
Rys. 10 Szkic wyglądu strony 

Pierwszym problemem, z jakim musimy sobie poradzid, jest podzielenie strony na główne obszary. 
Jeśli przyjrzysz się rysunkowi, zauważysz, że można wyodrębnid dwa główne elementy, oznaczone 
na rysunku pogrubioną linią: nagłówek strony oraz jej treśd. Możemy zdefiniowad je za pomocą 
znaczników <div>. Dodatkowo każdemu z nich warto nadad atrybut id, aby można było 
jednoznacznie je identyfikowad. By ułatwid pozycjonowanie, możemy dodad jeszcze jeden, 
dodatkowy znacznik <div>, który obejmie całą stronę: 

<body> 
 <div id="Strona"> 
  <div id="Naglowek"></div> 
  <div id="Tresc"></div> 
 </div> 
</body> 

Teraz należy przeanalizowad zawartośd głównych elementów. Rozpoczniemy od nagłówka. Składa 
się on z trzech głównych elementów: logo, menu oraz obszaru logowania. Postępując według tej 
samej zasady, co poprzednio, powinniśmy otrzymad: 

<div id="Naglowek"> 
 Logo 
 <div id="Menu">Menu</div> 
 <div id="ObszarLogowania">Zaloguj</div> 
</div> 

W analogiczny sposób możemy wyróżnid trzy obszary, w których prezentowana będzie treśd strony: 

<div id="Tresc"> 
 <div id="PierwszyObszarBoczny">Pierwszy obszar boczny</div> 
 <div id="DrugiObszarBoczny">Drugi obszar boczny</div> 
 <div id="ObszarRoboczy">Obszar roboczy</div> 
</div> 

Możemy teraz podejrzed tak przygotowany dokument w przeglądarce. Jak łatwo zauważyd, na razie 
wyglądem strona w ogóle nie przypomina tej z rysunku. Mimo to prace nad kodem HTML możemy 
praktycznie zakooczyd. 

Podejście hierarchiczne ułatwia nam zarządzanie wyglądem strony. Zmiana właściwości elementu 
nadrzędnego powoduje zmianę wszystkich elementów podrzędnych. Podział hierarchiczny może 
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wynikad z dwóch czynników, po pierwsze z logicznego podziału strony, po drugie z podziału strony 
na elementy podobne. 

Definiowanie reguł CSS dla dokumentu – definiowanie ułożenia elementów 

W kolejnym kroku powinniśmy utworzyd arkusz stylów (np. plik Style.css) i dołączyd go do 
dokumentu przy pomocy znacznika <link>. W pliku zdefiniujemy reguły, które pozwolą wyświetlid 
obok siebie obszary, w których prezentowana jest treśd. Aby odwoład się do tych elementów 
posłużymy się selektorem ID: 

#PierwszyObszarBoczny { width:200px; height:300px; float:left; } 
#DrugiObszarBoczny    { width:200px; height:300px; float:right; } 

Zdefiniowaliśmy rozmiar obu elementów oraz przyciąganie elementu do krawędzi bocznych innych 
elementów (w tym przypadku elementu nadrzędnego <div id="Tresc">). Możemy teraz 
uruchomid stronę w przeglądarce i zweryfikowad poprawnośd reguł. Obszary boczne zgodnie z 
oczekiwaniami wyświetlane są przy przeciwległych krawędziach strony.  

Teraz zajmiemy się obszarem roboczym (<div id="ObszarRoboczy">). W pierwszym kroku 
spróbujemy określid jego aktualny zasięg. W tym celu zdefiniujemy dla niego kolor tła, dodając 
następującą regułę CSS: 

#ObszarRoboczy { background-color: #EEE; } 

Możemy teraz zapisad plik CSS i odświeżyd stronę w przeglądarce. Jak zauważymy, obszar roboczy 
jest aktualnie wyświetlany na całą szerokośd strony. Powinniśmy odsunąd go od lewej i prawej 
krawędzi o 200px, aby zrobid miejsce dla obszarów bocznych. W tym celu zastosujemy marginesy. 
Dodatkowo wprowadzimy marginesy wewnętrzne, aby treśd prezentowana w obszarze głównym 
nie zlewała się z treścią wyświetlaną w pozostałych obszarach. Po zmodyfikowaniu zdefiniowana 
wcześniej reguła CSS powinna międ następującą postad: 

#ObszarRoboczy { background-color: #EEE;  
 padding: 50px 20px; 
 margin: 0 200px; } 

Jeśli teraz zapiszemy plik CSS i odświeżymy stronę w przeglądarce, zauważymy, że obszar główny 
jest wyświetlany tak, jak oczekiwaliśmy.  

Definiowanie reguł CSS dla dokumentu – definiowanie wyglądu elementów 

Otrzymaliśmy stronę, której elementy są odpowiednio ułożone. W kolejnym kroku określimy 
wygląd poszczególnych elementów. Rozpoczniemy od zdefiniowania wyglądu elementu na 
najwyższym poziomie hierarchii. Dla treści strony internetowej takim elementem jest znacznik 
<body>. Do określenia jego właściwości, w pliku CSS, wykorzystamy selektor typu: 

body { 
 font-family: Verdana; 
 font-size: 8pt; 
 color: #000033; } 

Określimy teraz nie tylko wygląd tekstu wyświetlanego bezpośrednio w znaczniku <body>, ale 
również wszystkich znaczników zagnieżdżonych, w tym przypadku wszystkich tekstów na stronie. 
Zajmiemy się teraz elementami nagłówka. 

Określimy właściwości elementu <div id="Menu">. Dla tego elementu określimy inny kolor tła 
oraz zmniejszymy wyświetlany tekst. W pliku CSS dodajemy następującą regułę: 

#Menu { 
 background-color: #55BBFF; 
 font-size: 7.5pt; } 
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Dla elementu <div id="ObszarLogowania"> określimy wyrównanie do prawej, inny kolor tła oraz 
marginesy wewnętrzne. Reguła w pliku CSS będzie miała postad: 

#ObszarLogowania { 
 text-align: right; 
 background-color: #C3DBEA; 
 padding: 5px 10px; } 

Jeśli teraz zapiszemy plik CSS i odświeżymy stronę w przeglądarce, zauważymy, że wszystkie 
elementy są wyświetlane zgodnie ze szkicem strony przedstawionym na Rys. 10. Teraz jedyne co 
pozostało, to dodad treśd do naszej nowej strony. 

Porady praktyczne 

Uwagi ogólne  

 Pamiętaj, że Twoje strony powinny wyświetlad się poprawnie we wszystkich 
najpopularniejszych przeglądarkach internetowych, co ze względu na różnice w interpretacji 
CSS może byd czasem trudne. 

 Sprawdzaj zgodnośd kodu HTML oraz CSS ze standardami przy pomocy walidatorów na 
stronach W3C. Jeśli Twoja strona spełnia wymagania standardów, to umieśd na niej 
informację o zgodności. Możesz w tym celu wykorzystad kod zawarty na stronach 
walidatorów W3C. 

 Staraj się umieszczad w kodzie CSS komentarze. W ten sposób nawet rok po jego napisaniu 
będziesz mógł szybko przypomnied sobie, do czego służą poszczególne reguły. 

 Organizuj arkusze stylów, np. dzieląc je na sekcje. Dobra organizacja pliku ułatwia jego 
modyfikację i przeglądanie w przyszłości. 

 Jeśli w regule określasz wartośd 0, możesz pominąd jednostkę (np. zamiast 0px możesz 
napisad 0). 

Stosowanie stylów w dokumentach XHTML 

 Możliwe jest dobieranie stylów na podstawie atrybutów class i id, jak również 
definiowanie ich bezpośrednio jako wartośd atrybutu style. Najczęściej powinieneś 
stosowad klasy, ponieważ umożliwiają one wielokrotne wykorzystanie tych samych definicji, 
natomiast zdecydowanie powinieneś unikad stosowania atrybutu style. Jeśli chcesz nadad 
unikatowy styl jakiemuś elementowi, skorzystaj z atrybutu id. 

 Jako wartośd atrybutu class możesz podad wiele klas, np. <div class="pierwszy 
drugi">. Powinieneś jednak uważad, aby wskazane style nie określały tych samych 
własności, bo różne przeglądarki mogą odmiennie to zinterpretowad.  

 W nazwach elementów i klas zawsze używaj słów określających ich znaczenie (np. 
id="Menu" lub class="ObszarBoczny"), a nie ułożenie na stronie lub wygląd 
(np. id="LewyObszarBoczny" lub class="NiebieskieTło"). W koocu jedną 
z największych zalet CSS jest umożliwienie kompletnej zmiany wyglądu stron bez potrzeby 
modyfikowania dokumentów HTML. 

Definiowanie układu elementów na stronie  

 Staraj się nie używad tabel do układania elementów. Stosując je utrudniasz dostęp do treści 
i możliwośd zmiany wyglądu strony w przyszłości. 

 Układ elementów na stronie można zdefiniowad wykorzystując statyczne pozycjonowanie 
lub pływanie. Oba podejścia mają wady. Pływanie jest trudne do opanowania, a 
pozycjonowanie ogranicza elastycznośd układu strony. O wyborze jednego z nich powinny 
zdecydowad wymagania względem strony. 
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Określanie wielkości pisma  

 Wielkośd pisma możemy określid m.in. w pikselach, punktach lub firetach (em). Wybór 
właściwej jednostki jest trudny. Wybierając piksele mamy największą kontrolę nad wyglądem 
strony, ale blokujemy możliwośd zmiany wielkości tekstu w przeglądarce. Problemu tego nie 
mamy, jeśli zastosujemy firety, jednak wówczas musimy upewnid się, że po zmianie rozmiaru 
tekstu w przeglądarce strona nadal wygląda tak, jak tego chcemy. 

 Rozmiar tekstu można określid wykorzystując wartości symboliczne: xx-small, x-small, 
small, medium, large, x-large, xx-large oraz smaller i larger. Ich użycie jest 
jednak niepraktyczne, bowiem nie wiemy dokładnie, jaką wielkośd przyjmie tekst 
wyświetlany w przeglądarce. 

Skrócona notacja 

Tam, gdzie to możliwe, powinieneś używad skróconej notacji CSS oraz grupowad style, np. zamiast: 

.styl1 { margin-top: 11px; margin-right: 11px; margin-bottom: 11px; 
         margin-left: 11px; } 
.styl2 { margin-top: 11px; margin-right: 11px; margin-bottom: 11px; 
         margin-left: 11px; } 

powinieneś napisad: 

.styl1, .styl2 { margin: 11px; } 

Uwagi dla studenta 

Jesteś przygotowany do realizacji laboratorium jeśli: 

 rozumiesz zasadę i potrzebę budowania dokumentów XHTML przyjaznych dla CSS 

 umiesz posługiwad się selektorami 

 umiesz zmienid istniejący dokument w języku HTML na zgodny z XHTML i przyjazny dla CSS 

 potrafisz podad przykłady przestarzałych znaczników HTML, które można zastąpid przy 
pomocy CSS 

 umiesz zdefiniowad w pliku CSS podstawowe własności związane z wyglądem i położeniem 
elementu na stronie 

 umiesz podad przykład zastosowania CSS, jego wady i zalety 

 wiesz, w jaki sposób można określid reguły CSS w Visual Studio 2008 

Pamiętaj o zapoznaniu się z uwagami i poradami zawartymi w tym module. Upewnij się, że 
rozumiesz omawiane w nich zagadnienia. Jeśli masz trudności ze zrozumieniem tematu zawartego 
w uwagach, przeczytaj ponownie informacje z tego rozdziału i zajrzyj do notatek z wykładów. 

Dodatkowe źródła informacji 

1. Eric A. Meyer, CSS według Erica Meyera. Kolejna odsłona, Helion, 2005 

W książce autor prezentuje możliwości CSS na przykładzie różnych projektów 
prezentując krok po kroku ich rozwiązanie. 

2. Dave Shea, Molly E. Holzschlag, Zen stosowania CSS, Helion, 2006 

Jest to książka autora witryny CSS Zen Garden. Na przykładzie różnych projektów 
opisuje on różnorodne aspekty tworzenia stron, m.in. projektowanie, układ, 
typografia czy efekty specjalne. 

3. Working with CSS Overview, http://msdn2.microsoft.com/en-us/library/bb398931.aspx 

Na stronie opisano możliwości pracy z CSS w Visual Studio 2008. 

4. Cascading Style Sheets, http://www.w3.org/Style/CSS 
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Na stronie znajdziesz wszystkie informacje związane ze standardem CSS.  

5. CSS Zen Garden, http://www.csszengarden.com 

Na stronie znajdziesz przykłady zastosowania wielu stylów do jednej strony. 

6. CSS Vault, http://cssvault.com 

Na stronie znajdziesz przykłady zastosowania CSS w różnych projektach. 

7. Open Source Web Design, http://www.oswd.org 

Na stronie znajdziesz setki gotowych projektów szablonów stron. 
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Laboratorium podstawowe 

Problem 1 (czas realizacji 20 min) 

Jesteś właścicielem niewielkiej firmy komputerowej wykonującej różnego rodzaju zlecenia. Właśnie 
dzisiaj przyszedł do Ciebie Twój dobry klient i poprosił o przygotowanie dla niego strony 
internetowej jego firmy zajmującej się handlem nieruchomościami. Przedstawił Ci swoją koncepcję 
układu elementów na stronie (Rys. 11) i zaproponował, abyś w oparciu o nią przygotował szablon 
wyglądu. Ucieszyłeś się i przyjąłeś zlecenie, gdyż dodatkowe pieniądze są zawsze potrzebne, jednak 
po chwili odkryłeś, że wszyscy Twoi pracownicy są już obłożeni pracą na następnych kilka dni. 
Postanowiłeś zatem sam wykonad zadanie. 

 
Rys. 11 Szkic wyglądu strony 

Pamiętaj, że strona musi byd zgodna ze standardem XHTML oraz CSS. Powinieneś zweryfikowad to 
za pomocą walidatorów na stronie W3C. 

 

Zadanie Tok postępowania 

1. Utwórz nową 
stronę w Visual 
Studio 2008  

 Otwórz Visual Studio 2008. 

 Z menu wybierz File -> New -> Web Site. 

 Z listy Visual Studio installed templates wybierz Empty Web Site. 

 Z listy Location wybierz File System, a w polu obok określ lokalizację dla 
pliku w dowolnym miejscu na dysku. 

 Z listy Language wybierz Visual C#. 

 Kliknij OK. 

2. Dodanie 
strony do 
projektu. 
Utworzenie 
głównych 
elementów strony 

 Wybierz Website -> Add New Item. 

 Z listy Visual Studio installed templates wybierz HTML Page. 

 W polu Name wpisz Szablon.htm. 

 Kliknij OK. 

 Zmieo typ dokumentu z XHTML 1.0 Transitional na XHTML 1.1, 
modyfikując pierwszą linię pliku do postaci: 

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.1//EN" 
"http://www.w3.org/TR/xhtml11/DTD/xhtml11.dtd"> 

 Zmieo tytuł strony na „Strona firmowa”. 

 Wewnątrz znacznika <body> dodaj: 

<div id="Strona"> 
 <div id="Naglowek"></div> 
 <div id="Tresc"></div> 
</div> 

3. Podział 
głównych 

 Wewnątrz znacznika zawierającego nagłówek (id="Naglowek") dodaj: 

Logo 
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elementów <div id="Menu">Menu</div> 
<div id="ObszarLogowania">Zaloguj</div> 

 Wewnątrz znacznika zawierającego treśd (id="Tresc") dodaj: 

<div id="PierwszyObszarBoczny">Pierwszy obszar boczny</div> 
<div id="DrugiObszarBoczny">Drugi obszar boczny</div> 
<div id="ObszarRoboczy">Obszar roboczy</div> 

4. Sprawdzenie 
wyniku prac 

 W oknie Solution Explorer kliknij prawym przyciskiem myszy plik 
Szablon.htm, a następnie wybierz View In Browser. 

Czy w przeglądarce internetowej strona wygląda tak, jak na szkicu? 
Dlaczego nie? 

5. Dodanie 
nowego arkusza 
stylów 

 Wybierz Website -> Add New Item. 

 Z listy Visual Studio installed templates wybierz Style Sheet. 

 W polu Name wpisz Style.css. 

 Kliknij OK. 

6. Określenie 
pozycji 
w obszarach 
roboczych 

 Przełącz widok strony na Design lub Split. 

 Wybierz Format -> New Style. 

 W polu Selector wpisz #PierwszyObszarBoczny. 

 W górnej części okna z listy Define in wybierz Existing Style Sheet, 
a z listy rozwijanej URL wybierz  Style.css. 

 Z listy Category wybierz Layout, a następnie określ właściwośd float: 
left. 

 Z listy Category wybierz Position, a następnie określ właściwości width: 
200 px oraz height: 300 px. 

 Kliknij OK. 

 Postępuj podobnie z selektorem #DrugiObszarBoczny, tylko zmieo 
właściwośd float na right. 

7. Określenie 
podstawowego 
wyglądu 
zawartości strony 

 W pliku Style.css standardowo jest już dodany selektor znacznika 
<body>. Kliknij go prawym przyciskiem myszy i wybierz Build Style. 

 Określ właściwości font-family: Verdana, font-size: 8 pt i color: 
#000033. 

 Z listy Category wybierz Background, a następnie określ właściwośd 
backgroud-color: white. 

 Z listy Category wybierz Box, a następnie określ właściwośd margin: 0. 
Upewnij się, że opcja Same for all jest zaznaczona. 

 Kliknij OK. 

 Otwórz plik Szablon.htm. W oknie Solution Explorer chwyd myszką plik 
Style.css i upuśd go w sekcji nagłówka strony za znacznikiem </title>. 
Zobacz jak zmienił się podgląd pliku. 

8. Określenie 
wyglądu 
pozostałych 
elementów strony  

 Przy pomocy narzędzi Visual Studio lub w kodzie pliku Style.css określ 
następujące style: 

— #Menu: kolor tła: #55BBFF, wielkośd tekstu: 7.5pt. 
— #ObszarLogowania: wyrównanie tekstu (właściwośd text-align): do 

prawej, kolor tła #C3DBEA, margines wewnętrzny (ang. padding) 
z góry i dołu 5px, z lewej i prawej 10px. 

— #ObszarRoboczy: kolor tła #EEE, margines wewnętrzny (ang. 
padding) z góry i dołu 50px, z lewej i prawej 20px, margines z góry 
i dołu 0, z lewej i prawej 200px. 



Piotr Bubacz  Moduł 2 
ITA-103 Aplikacje internetowe  Kaskadowe Arkusze Stylów – CSS 

Strona 2-16 

9. Sprawdzenie 
wyglądu strony w 
przeglądarce  

 W oknie Solution Explorer kliknij prawym przyciskiem myszy plik 
Szablon.htm i wybierz View In Browser. 

 Strona w przeglądarce powinna wyglądad podobnie jak na Rys. 12. 

 
Rys. 12 Wygląd strony po zastosowaniu stylów 

10. Sprawdzenie 
poprawności na 
stronie W3C 

 Wejdź na stronę http://validator.w3.org i zweryfikuj poprawnośd 
dokumentu XHTML.  

Czy Twój dokument jest zgodny ze standardem XHTML? Jeśli nie, to 
przeanalizuj błędy i spróbuj je poprawid. 

 Wejdź na stronę http://jigsaw.w3.org/css-validator i zweryfikuj 
poprawnośd arkusza CSS. 

Czy Twój arkusz stylów jest zgodny ze standardem CSS? Jeśli nie, to 
przeanalizuj błędy i spróbuj je poprawid. 

11. Dodanie 
informacji o 
zgodności ze 
standardami 

 Wewnątrz znacznika zawierającego obszar roboczy 
(id="ObszarRoboczy") dodaj następujący kod: 

<p> 
 <a href="http://validator.w3.org/check?uri=referer"> 
  <img style="border:0;width:88px;height:31px" 
    src="http://www.w3.org/Icons/valid-xhtml11-blue" 
    alt="Valid XHTML 1.1" /></a> 
 <a href="http://jigsaw.w3.org/css-validator/"> 
  <img style="border:0;width:88px;height:31px" 
    src="http://jigsaw.w3.org/css-validator/images/vcss-blue" 
    alt="Poprawny CSS!" /></a> 
</p> 

12. Zamiana 
położenia 
obszarów 
bocznych 

 W pliku Style.css w regule z selektorem #PierwszyObszarBoczny zmieo 
właściwośd float na right. 

 W regule z selektorem #DrugiObszarBoczny zmieo właściwośd float na 
left.  

Czy oba obszar zamieniły się miejscami? Jakie kroki musiałbyś 
wykonad, gdyby dokument sformatowany był z użyciem tabel? 

13. Przygotowanie 
propozycji własnej 
stylistyki 

 Przygotuj arkusz CSS zawierający Twoją propozycję nowego wyglądu 
strony. Zmieo kolory, krój tekstu i inne właściwości. 
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Problem 2 (czas realizacji 25 min) 

Akurat wtedy, kiedy skooczyłeś pracę nad szablonem, przyszedł do Ciebie kolejny klient. Przyniósł 
ze sobą stronę przygotowaną kilka lat wcześniej i poprosił, abyś dostosował ją do obecnych 
standardów. Bardzo zależało mu na zachowaniu obecnego wyglądu i układu elementów, jednak 
z możliwością łatwego wprowadzania zmian w przyszłości. Spojrzałeś w kod i zauważyłeś, że do 
rozmieszczania elementów strony używane są tabele, zaś wygląd definiowany jest przy użyciu 
przestarzałych znaczników, takich jak <b>, <i> czy <font>. Uświadomiłeś sobie, że praktycznie 
trzeba będzie przepisad kod od początku, ale ponieważ klientowi w potrzebie nigdy się nie 
odmawia, zgodziłeś się podjąd zadania. 

 

Zadanie Tok postępowania 

1. Utwórz  nową 
stronę w Visual 
Web Developer 
2008 Express 
Edition 

 Otwórz Visual Web Developer 2008 Express Edition. 

 Z menu wybierz File -> New Web Site. 

 Z listy Visual Studio installed templates wybierz Empty Web Site. 

 Z listy Location wybierz File System, a w polu obok określ lokalizację 
pliku w dowolnym miejscu na dysku. 

 Z listy Language wybierz Visual C#. 

 Kliknij OK. 

2. Dodanie 
oryginalnej strony 
do projektu 

 Dodaj do projektu istniejący plik StronaGlowna.htm. Wybierz Website 
-> Add Existing Item, a następnie wskaż jego lokalizację. 

 Otwórz stronę klikając dwukrotnie plik StronaGlowna.htm w oknie 
Solution Explorer. 

3. Sprawdzenie 
poprawności 
dokumentu 

 Źródło dokumentu przekopiuj na stronę http://validator.w3.org do pola 
w zakładce Validate by Direct Input. 

 Wciśnij przycisk Check. 

Ile błędów jest na stronie? 

 Z listy Doctype wybierz XHTML 1.1 i wciśnij przycisk Revalidate.  

Ile błędów jest wyświetlanych teraz? 

4. Utworzenie 
szablonu strony 

 Wybierz Website -> Add New Item. 

 Z listy Visual Studio installed templates wybierz HTML Page. 

 W polu Name wpisz Szablon.htm. 

 Kliknij OK. 

 Zamieo zawartośd pliku na: 

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.1//EN" 
"http://www.w3.org/TR/xhtml11/DTD/xhtml11.dtd"> 
<html xmlns="http://www.w3.org/1999/xhtml"> 
<head><title>Lorem ipsum dolor sit amet</title></head> 
<body> 
  <div id="Strona"> 
   <div id="Naglowek"> 
    <h1></h1> 
    <h2></h2> 
   </div> 
   <div id="Tresc"> 
    <div id="Obszar1"> 
     <div class="Ramka"></div> 
     <div class="Ramka"></div> 
     <div class="Ramka Ostatnia"></div> 
    </div> 
    <div id="Obszar2"></div> 



Piotr Bubacz  Moduł 2 
ITA-103 Aplikacje internetowe  Kaskadowe Arkusze Stylów – CSS 

Strona 2-18 

    <div id="ObszarGlowny"></div> 
    <div id="Obszar3"> 
     <div class="Ramka"></div> 
     <div class="Ramka Ostatnia"></div> 
    </div> 
   </div> 
   <div id="Stopka"></div> 
  </div> 
</body> 
</html> 

Zauważ, że został zmieniony standardowy typ dokumentu 
z XHTML 1.0 Transitional na XHTML 1.1. 

 Przekopiuj treśd z pliku StronaGlowna.htm do nowo utworzonego 
szablonu na podstawie wskazówek poniżej. 

 Do wnętrza znacznika <h1> przekopiuj tekst z pierwszego wiersza 
tabeli. 

 Do wnętrza znacznika <h2> przekopiuj tekst z drugiego wiersza tabeli. 

 Do wnętrza znacznika o id="Stopka" przekopiuj tekst z ostatniego 
wiersza tabeli. 

 Tekst zapisany stylem pogrubionym umieśd wewnątrz znaczników 
<h3>. 

 Resztę tekstu umieśd wewnątrz znaczników <p>. 

 Wewnątrz znacznika o id="ObszarGlowny", pomiędzy znacznikami 
<h3> i <p>, dodaj następujący kod: 

<img src="Pictures/WebPage.png" alt="Web page" /> 

5. Dodanie 
nowego arkusza 
stylów 

 Wybierz Website -> Add New Item. 

 Z listy Visual Studio installed templates wybierz Style Sheet. 

 W polu Name wpisz Style.css. 

 Kliknij OK. 

6. Określenie 
podstawowego 
ułożenia strony 

 Do pliku Style.css dodaj następujące reguły: 

#Obszar1 { float: left; width: 620px; } 
#Obszar2 { float: right; width: 200px; } 
#Strona { width: 620px; } 
#Tresc { float: left; width: 620px; } 
.Ramka { float: left; width: 200px; } 

7. Sprawdzenie 
wyglądu strony w 
przeglądarce 

 Otwórz plik Szablon.htm. W oknie Solution Explorer chwyd myszką plik 
Style.css i upuśd go w sekcji nagłówka strony za znacznikiem </title>. 

 W oknie Solution Explorer kliknij prawym przyciskiem myszy plik 
Szablon.htm i wybierz View In Browser. Zobacz jak wygląda 
projektowana strona. 

8. Określenie 
wyglądu strony 

 Przy pomocy narzędzi Visual Studio lub w kodzie pliku Style.css określ 
style dla wymienionych niżej elementów. 

 Dla elementu body: 

— Kolor tła: #708090 
— Kolor czcionki: #F5F5F5 

 Dla elementów h1: 

— Rodzinę fontów: Arial, Helvetica, sans-serif 
— Margines górny: 0 
— Wyrównanie: wyśrodkowane 
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 Dla elementów h2: 

— Wielkośd tekstu: 1em 
— Styl tekstu: kursywa  
— Margines: 0 

 Dla elementów h3: 

— Wielkośd fontów: 1em 
— Styl fontów: pogubienie 
— Margines: 0 

 Dla elementów img: 

— Pływanie: do lewej 
— Margines: 10px 10px 10px 0 
— Szerokośd: 172px 

 Dla elementów p: 

— Margines: 0 

 Dla elementu o id="Obszar2" dodaj: 

— Margines górny: 10px 

 Dla elementu o id="Strona" dodaj: 

— Margines lewy: auto 
— Margines prawy: auto 

 Dla elementu o id="Tresc" dodaj: 

— Margines górny i dolny: 10px 
— Margines prawy i lewy: 0 

 Dla elementu o id=" Obszar3" oraz id="ObszarGlowny": 

— Pływanie: do lewej 
— Margines górny: 10px 
— Szerokośd: 410px  

 Dla elementu o id="Stopka" dodaj: 

— Styl fontów: pogubienie 
— Wyrównanie: wyśrodkowane 

 Dla elementów klasy Ramka dodaj: 

— Margines prawy: 10px 

 Dla elementów klasy Ostatnia: 

— Margines prawy: 0 

 Dla elementów klasy Ikona: 

— Obramowanie: 0 
— Szerokośd: 88px 
— Wysokośd: 31px 

9. Sprawdzenie 
wyglądu strony w 
przeglądarce 

 W oknie Solution Explorer kliknij prawym przyciskiem myszy plik 
Szablon.htm i wybierz View In Browser. Zobacz jak teraz wygląda 
projektowana strona. 
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 Strona powinna wyglądad podobnie do strony StronaGlowna.htm. 

10. Sprawdzenie 
poprawności na 
stronie W3C 

 Wejdź na stronę http://validator.w3.org i zweryfikuj poprawnośd 
dokumentu XHTML.  

Czy Twój dokument jest zgodny ze standardem XHTML? Jeśli nie, to 
przeanalizuj błędy i spróbuj je poprawid. 

 Wejdź na stronę http://jigsaw.w3.org/css-validator i zweryfikuj 
poprawnośd arkusza CSS. 

Czy Twój arkusz stylów jest zgodny ze standardem CSS? Jeśli nie, to 
przeanalizuj błędy i spróbuj je poprawid. 

11. Dodanie 
informacji o 
zgodności ze 
standardem 

 Wewnątrz znacznika o id="Stopka" dodaj następujący kod: 

<p> 
 <a href="http://validator.w3.org/check?uri=referer"> 
  <img class="Ikona" 
    src="http://www.w3.org/Icons/valid-xhtml11-blue" 
    alt="Valid XHTML 1.1" /></a> 
 <a href="http://jigsaw.w3.org/css-validator/"> 
  <img class="Ikona" 
    src="http://jigsaw.w3.org/css-validator/images/vcss-blue" 
    alt="Poprawny CSS!" /></a> 
</p> 

12. Przygotowanie 
propozycji własnej 
stylistyki 

 Przygotuj arkusz CSS zawierający Twoją propozycję nowego wyglądu 
strony. Zmieo kolory, krój tekstu i inne właściwości. 
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Laboratorium rozszerzone 

Zadanie 1 (czas realizacji 45 min) 

Przygotowałeś dla klienta stronę internetową z wykorzystaniem XHTML i CSS. Ten bardzo się 
ucieszył, że jest ona zgodna ze standardami i można łatwo wprowadzad w niej modyfikacje, 
a ponieważ zbliża się rocznica powstania jego firmy, zaproponował, abyś z tej okazji przygotował 
propozycję nowego układu oraz wyglądu strony. Ponieważ nie masz dużego doświadczenia 
w dziedzinie projektowania, postanowiłeś poszukad inspiracji na jednej z witryn oferujących 
gotowe rozwiązania. Z pomocą wyszukiwarki trafiłeś na stronę Open Source Web Design 
(http://www.oswd.org), oferującą darmowe szablony. Spróbuj zaadoptowad style z któregoś 
z projektów do strony przygotowanej w poprzednim zadaniu. 

Zadanie 2 (czas realizacji 45 min) 

Spółka usługowo-handlowa Kowalski-Sale posiada witrynę internetową wykonaną 4 lata temu. 
Firma się rozwija i w związku z tym chciałaby odświeżyd wizerunek oraz rozszerzyd informacje na 
swojej stronie. Niestety nie jest to łatwe, gdyż do zdefiniowania wyglądu i ułożenia elementów 
zostały użyte tabele i przestarzałe znaczniki. Przeanalizuj dokumenty zawarte w archiwum 
Kowalski-Sale.zip i opracuj nową wersję strony zgodną ze standardami XHTML i CSS. Przygotuj co 
najmniej dwie różne wersje układu i wyglądu strony. 

Zadanie 3 (czas realizacji 90 min) 

Starasz się o świetnie płatną pracę w dużej firmie tworzącej aplikacje internetowe. Jesteś jednym 
z kilku kandydatów, którzy przeszli do drugiej tury rozmów. Twój przyszły pracodawca postanowił 
sprawdzid Twoje umiejętności posługiwania się kaskadowymi arkuszami stylów, prosząc Cię 
o przygotowanie pliku CSS dla strony głównej witryny CSS Zen Garden (http://csszengarden.com).  

Podpowiedź: w serwisie znajdują się przykładowe pliki CSS przygotowane przez innych 
użytkowników. Zobacz, jak został w nich zdefiniowany wygląd strony głównej. Pamiętaj, że w firmie 
działa system antyplagiatowy! 

Zadanie 4 (czas realizacji 90 min) 

Jesteś niezależnym projektantem stron internetowych. Twoim nowym zleceniem jest 
przygotowanie profesjonalnie wyglądającej galerii zdjęd. Twój klient określił następujące 
wymagania: 

 Strona powinna byd zgodna ze standardem XHTML 1.1 oraz CSS 2.1. 

 Wygląd strony musi byd zdefiniowany w zewnętrznym pliku CSS. 

 Na głównej stronie galerii ma byd wyświetlana lista miniatur zdjęd wraz z odnośnikami do 
zdjęcia. Każda miniatura musi byd umieszczona w wystylizowanej w CSS ramce. Ilośd miniatur 
w wierszu ma byd zależna od szerokości okna przeglądarki. 

Jako zawartośd galerii wykorzystaj wybrane przez siebie zdjęcia umieszczone w serwisie Live Spaces 
(http://www.spaces.live.com). 


